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       Introducing Access    

        T  he word  database  is prone to making most people feel kind of queasy. Can 
you blame them? Database terminology — record, fi eld, and fi lter  —  is the 
worst of the worst. It even puts other computer terminology to shame. 

Databases intimidate most people. Even brave souls with a considerable amount 
of experience in Word and Excel shy away from  Access,  the Offi  ce 365 database 
program. However, Access can be invaluable for storing and organizing customer 
lists, inventories, addresses, payment histories, donor lists, and volunteer lists. 

 This chapter introduces databases and the concepts behind databases. It shows 
you how to create a database and database tables for storing information. The 
second half of this chapter explains how to design databases. Sorry, but you have 
to know about database design before you can start fooling with databases. You 
can’t jump right in as you can with the other Offi  ce programs. 

Access off ers a practice database called Northwind that you can experiment with 
as you get to know your way around databases. To open this database, click the 
File tab and choose New. Then, in the New window, enter  Northwind  in the Search 
box and click the Start Searching button.  

  What Is a Database, Anyway? 
 You may not know this, but you’re no stranger to databases. The address book on 
your computer is a database. The telephone directory in the desk drawer is, too. 
A recipe book is also a database, in that recipes are categorized under diff erent 

Chapter 1

 IN THIS CHAPTER 

 »     Understanding how databases work  

 »   Looking at tables, queries, forms, and 
other database objects  

 »   Creating a database  

 »   Designing the tables, queries, forms, 
and the other parts of a database    
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headings. If you ever arranged a CD collection in a certain way — in alphabetical 
order or by musical genre, for example — you created a database of CDs, one that 
makes finding a particular CD easier. Any place where information is stored in a 
systematic way can be considered a database. The only difference between a comput-
erized database and a conventional database, such as a telephone directory, is that 
storing, finding, and manipulating data is much easier in a computerized database.

Imagine how long it would take to find all the New York addresses in an address 
list with 10,000 entries. In Access, you can query a 10,000-entry database and 
find all New York addresses in a matter of seconds. For that matter, you can query 
to find all the addresses in a certain ZIP code. You can put the list in alphabetical 
order by last name or in numerical order by ZIP code. Doing these chores without 
a computer requires many hours of dreary, monotonous labor.

Tables, Queries, Forms, and Other Objects
One problem with getting to know a database program — and the primary reason 
that people are intimidated by databases — is that you can’t jump right in. You 
have to know how data is stored in a database and how it is extracted, to use 
database terminology. You have to know about objects, Access’s bland word for 
database tables, queries, forms, and all else that makes a database a database. To 
help you get going, these pages offer a crash course in databases. They explain the 
different objects — tables, queries, forms, and reports — that make up a database. 
Fasten your seatbelt. If you complete the crash course without crashing, you’re 
ready to create your first database.

Database tables for storing information
Information in databases is stored in database tables like the one in Figure 1-1. In 
a database table, you include one field for each category of information you want 
to keep on hand. Fields are the equivalent of columns in a table. Your first duty 
when you create a database table is to name the fields and tell Access what kind of 
information you propose to store in each field. The database table in Figure 1-1 is 
for storing employee information. It has eight fields: ID, First Name, Last Name, 
E-mail Address, Business Phone, Company, Job Title, and Home Phone.

A database can comprise one database table or many different tables that are 
linked together. If you’re dealing with a lot of information, storing data in more 
than one table is to your advantage. Later in this chapter, “Separating information 
into different database tables” explains why storing data across several database 
tables is advantageous.
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FIGURE 1-1:  
A database table.

ACCESS DATABASE TERMINOLOGY
Stumbling over database terminology is easy. To keep yourself from stumbling, fold 
back the corner of this page and return here if one of these database terms puzzles you:

•	Cell: In a database table, a place for entering one piece of data. Cells appear in a 
database table where a field and record intersect.

•	Database: A systematic way of organizing information so that it can be retrieved 
and manipulated easily.

•	Database table: A collection of data records arranged into well-defined categories, 
or fields. Most relational databases have more than one table.

•	Dynaset: The results of a search for data in a database. (This term is short for 
dynamic set.) A dynaset is not to be confused with a dinosaur.

•	 Field: One category of information in a database table. Fields are the equivalent of 
columns in a conventional table.

•	 Filtering: Finding the records in a database table that have the same or nearly the 
same field value. Filtering is a more convenient but not as sophisticated means of 
querying a database.

•	 Foreign key field: In a relationship between two database tables, the field that is 
on the “many” side of a one-to-many relationship. The primary key field is on the 
“one” side.

(continued)
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Forms for entering data
After you create the fields in the database table, you can start entering the records. 
A record describes all the data concerning one person or thing. Although you can 
enter records straight into a database table, the easiest way to enter a record is 
with a form. Similar to a dialog box, a form has convenient text boxes and drop-
down lists for entering information, as shown in Figure 1-2. On a form, you can 
see clearly what kind of information needs entering in each field.

Queries for getting the data out
Figure 1-3 shows a simple query for finding out which employees in the database 
table shown in Figure 1-1 are Sales Representatives. A query is a question you ask 
of a database. The question here is, “Who is a Sales Representative?” Notice the 
criterion “Sales Representative” in the Job Title field on the Query grid.

•	 Form: Similar to a dialog box, a place with text boxes and drop-down lists for 
entering records in a database table.

•	Module: A Visual Basic procedure whose job is to perform a certain task in Access.

•	Object: The catch-all term for the tables, queries, forms, and reports that you 
create and open starting in the Navigation pane.

•	Primary key field: The field in a database table where unique, one-of-a-kind data 
is stored. To query more than one database table at a time, the tables must have 
primary key fields.

•	Query: A question asked of a database that yields information. Queries can be 
made of a single database table, several tables, or even other queries.

•	Record: In a database table, all the data that has been recorded about one person 
or thing. A record is the equivalent of a row in a conventional table.

•	Relational database: A database program in which data is kept in more than one 
database table, relationships are established between tables, and queries can be 
conducted and reports made by assembling data from different tables. Access is a 
relational database. A database that permits only one table is a flat-file database.

•	Report: Information gathered from a database and laid out in such a way that it’s 
easy to read and understand. Reports are meant to be printed and distributed.

•	 Sort: To rearrange records in a database table so that the records appear in 
alphabetical, numerical, or date order in one field.

(continued)
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In an address database, you can use a query to find all the people in a particular 
ZIP code or state. If information about contributions is stored in the database, you 
can find out who contributed more than $500 last year. Queries can get very com-
plex. For example, you can find all the people in a particular city who contributed 
between $50 and $500 and volunteered more than eight hours in the past year. 
You can construct the query so that it produces each person’s name and telephone 
number, or you can construct it so that all the information you have concerning 
each person appears in the query results.

When you get junk mail, it likely comes to your mailbox as the result of a database 
query. Companies routinely buy and sell customer databases. They query these 
databases to gather the names of people who they believe are well-disposed to 
purchasing the products they sell. Next time you get junk mail solicitation, study 
the letter and ask yourself, “How did I get in this database, and which database 
query produced my name?” The junk mailer is probably targeting extraordinarily 
beautiful, intelligent people.

After you create a query, you can save it and run it again. You can use it as the 
basis for constructing new queries. The information in database tables usually 
changes over time. Customers change addresses. New products come online, and 
others are discontinued. But no matter how much the data changes, you can find 
out exactly what you want to know from a database by running a well-crafted 
query.

FIGURE 1-2:  
A form for 

entering data.
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Reports for presenting and examining data
Figure 1-4 shows a report. Reports can be made from database tables or from the 
results of queries. Reports are usually read by managers and others who don’t 
get their hands dirty in databases. They’re meant to be printed and distributed so 
that the information can be scrutinized and analyzed. Access offers many attrac-
tive reports. Don’t worry: The program does most of the layout work for you, and 
exporting reports to a Word file is easy.

FIGURE 1-3:  
Querying a 

database.
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Macros and modules
Macros and modules aren’t covered in this minibook, but they are also database 
objects. A macro is a series of commands. You can store macros for running que-
ries and doing other Access tasks. A module is a collection of Visual Basic proce-
dures and declarations for performing tasks in Access.

Creating a Database File
Creating a database is a lot of work, at least in the beginning. You have to design 
the database (a subject that I explain shortly). You have to enter the raw informa-
tion into the tables. You have to construct queries that allow yourself and others to 
read meaning into the data (see Chapter 4 of this minibook). By contrast, creating 
a database file for storing the information is the easy part.

Access offers two ways to create a new database file. You can do it from scratch or 
get the help of a template. With a template, some of the work is done for you. The 
template comes with prefabricated queries, forms, and reports. However, tem-
plates are for people who already know their way around Access databases. To 
make use of a template, you have to know how to modify a preexisting database.

Before you create a database file, start by deciding where in your computer to 
store it. Unlike other Office programs, Access requires you to save and name a new 
database file as soon as you create it.

FIGURE 1-4:  
A report gathers 
data for scrutiny 

and analysis.
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Creating a blank database file
Follow these instructions to create a blank database file:

1.	 On the File tab, choose New.

The New window appears.

2.	 Click the Blank Desktop Database icon.

A dialog box appears for choosing the folder where you will store your new 
database.

3.	 Click the Browse button.

You see the File New Database dialog box.

4.	 Select the folder where you want to keep the database file, enter a name 
in the File Name text box, and click OK.

5.	 Click the Create button.

The Navigation pane and a blank table appear. Later in this chapter, “Finding 
Your Way around the Navigation Pane” explains what this pane is all about. 
I suggest you go there without delay or deferral.

Getting the help of a template
As I explain earlier, templates are wonderful if you have the wherewithal to 
modify them. Access offers prefabricated databases for tracking assets, keeping 
inventory, scheduling resources, and doing other things. Unfortunately, the only 
way to find out whether one of the templates is worthwhile is to go to the trou-
ble to create a database from a template, open the database file, and look around.

Follow these steps to create a database file from a template:

1.	 On the File tab, choose New.

The New window opens.

2.	 Select a template or use the Search box to obtain a template online from 
Microsoft.

Templates showing the globe icon are applications, not databases. Access 
applications are designed for use with web browsers.

3.	 Click the Browse button.

The File New Database dialog box opens.
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4.	 Select the folder where you want to keep the database file, enter a name 
in the File Name text box, and click OK.

5.	 Click the Create button.

The Navigation pane and a blank table appear. Read on to find out how to find 
your way around the Navigation pane.

Finding Your Way around the 
Navigation Pane

The first thing you see when you open most database files is a Navigation pane 
like the one in Figure 1-5. This is the starting point for doing all your work in 
Access. From here, you can select an object — that horrible word again! — and 
begin working. Tables, queries, and other objects you create are added to the Nav-
igation pane when you create them.

Here are shorthand instructions for doing this, that, and the other thing in the 
Navigation pane:

»» Choosing an object type: Select a group (Tables, Queries, Forms, Reports, 
and so on) from the Object Type drop-down list at the top of the Navigation 
pane, or select All Access Objects to see all the groups, as shown in Figure 1-5.

»» Creating a new object: Go to the Create tab and choose what type of object 
you want to create. When creating new forms and reports, click a table or 
query in the Navigation pane to base the new form or report on a table or 
query.

»» Opening an object: To open a database table, query, form, or report, do one 
of the following: Double-click it; select it and press Enter; or right-click it and 
choose Open on the shortcut menu.

»» Opening an object in Design view: The task of formulating database tables, 
forms, and queries is done in Design view. If an object needs reformulating, 
right-click it and choose Design View on the shortcut menu.

»» Finding objects: Use the Search bar (located at the top of the Navigation 
pane) to search for objects.

»» Opening and closing the Navigation pane: Click the Shutter Bar Open/Close 
button on upper-right corner of the Navigation pane (or press F11) when you 
want to shrink it and get it out of the way. You can also resize this pane by 
clicking the far right edge and dragging it left or right.
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Designing a Database
Being a database designer isn’t nearly as glamorous as being a fashion designer, 
but it has its rewards. If you design your database carefully and correctly, it can be 
very useful to you and others. You can enter information accurately. When the time 
comes to draw information from the database, you get precisely the information 
you need. These pages explain everything you need to consider when designing a 
database. Pay close attention to “Separating information into different database 
tables,” later in this chapter, because the hardest part about designing a database 
is deciding how to distribute information across database tables and how many 
database tables to have.

FIGURE 1-5:  
Finding and 

selecting 
objects with the 

Navigation pane.
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Deciding what information you need
The first question to ask yourself is about the kind of information you want to get 
out of the database. Customer names and addresses? Sales information? Information 
for inventory tracking? Interview your coworkers to find out what information could 
be helpful to them. Give this matter some serious thought. Your goal is to set up the 
database so that every tidbit of information your organization needs can be recorded.

A good way to find out what kind of information matters to an organization is 
to examine the forms that the organization uses to solicit or record information. 
These forms show precisely what the organization deems worthy of tracking in 
a database. Figure 1-6, for example, shows the paper form that players fill out to 
sign up for a baseball league whose database tables appear in Figure 1-7. Compare 
Figure 1-6 with Figure 1-7 and you can see that the Players, Teams, and Divisions 
database tables all have fields for entering information from this form.

Separating information into different  
database tables
After you know the information you want to record in the database, think about 
how to separate the information into database tables. Many are tempted to put 

FIGURE 1-6:  
Paper forms 

also have fields.

FIGURE 1-7:  
Plans for 
database 

tables and 
field names.
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all the information into a single database table, but because Access is a relational 
database, you can query more than one table at a time, and in so doing, assemble 
information from different tables.

To see how it works, consider the simple database, as shown in Figure 1-7. The 
purpose of this little database and its four tables is to store information about the 
players, coaches, and teams in a baseball league. The Team Name field appears 
in three tables. It serves as the link among the tables and permits more than 
one to be queried. By querying individual tables or combinations of tables in this 
database, you can assemble team rosters, make a list of coaches and their contact 
information, list teams by division, put together a mailing list of all players, find 
out which players have paid their fee, and list players by age group, among other 
things. This database comprises four tables:

»» Players: Includes fields for tracking players’ names, addresses, birthdays, 
which teams they’re on, and whether they paid their fees

»» Coaches: Includes fields for tracking coaches’ names, addresses, and the 
names of the teams they coach

»» Teams: Includes fields for tracking team names and which division each team 
is in

»» Divisions: Includes fields for tracking division numbers and names

Deciding how many database tables you need and how to separate data across 
the different tables is the hardest part of designing a database. To make the task 
a little easier, do it the old-fashioned way with a pencil and eraser. Here are the 
basic rules for separating data into different tables:

»» Restrict a table to one subject only: Each database table should hold 
information about one subject only — customers, employees, products, and 
so on. This way, you can maintain data in one table independently from data 
in another table. Consider what would happen in the Little League database 
(refer to Figure 1-7) if coach and team data were kept in a single table, and 
one team’s coach was replaced by someone new. You would have to delete 
the old coach’s record, delete information about the team, enter information 
about the new coach, and reenter information about the team that you just 
deleted. But by keeping team information separate from coach information, 
you can update coach information and still maintain the team information.

»» Avoid duplicate information: Try not to keep duplicate information in the 
same database table or duplicate information across different tables. By 
keeping the information in one place, you have to enter it only once, and if 
you have to update it, you can do so in one database table, not several.
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Entire books have been written about database design, and this book can’t do the 
subject justice. You can, however, store all your data in a single table if the data 
you want to store isn’t very complex. The time you lose entering all the data in a 
single table is made up by the time you save not having to design a complex data-
base with more than one table.

Choosing fields for database tables
As I explain earlier, fields are categories of information. Each database table needs 
at least one field. If the table itself is a subject, you could say that its fields are 
facts about the subject. An Address database table needs fields for recording street 
addresses, cities, states, and ZIP codes. A Products database table needs fields 
for product ID numbers, product names, and unit prices. Just the facts, ma’am. 
Within the confines of the subject, the database table needs one field for each 
piece of information that is useful to your organization.

When you’re planning which fields to include in a database table, follow these 
guidelines:

»» Break up the information into small elements. For example, instead of a 
Name field, create a First Name field and a Last Name field. This way, you 
can sort database tables by last name more easily.

»» Give descriptive names to fields so that you know what they are later.  
A more descriptive name, such as Serial Number, is clearer than SN.

»» Think ahead and include a field for each piece of information your organiza-
tion needs. Adding a field to a database table late in the game is a chore. 
You have to return to each record, look up the information, and enter it.

»» Don’t include information that can be derived from a calculation. As I explain 
in Chapter 4 of this minibook, calculations can be performed as part of a 
query or be made part of a table. For example, you can total the numbers 
in two fields in the same record or perform mathematical calculations on 
values in fields.

Deciding on a primary key field  
for each database table
Each database table must have a primary key field. This field, also known as the 
primary key, is the field in the database table where unique, one-of-a-kind data 
is stored. Data entered in this field — an employee ID number, a part number, a 
bid number — must be different in each record. If you try to enter the same data 
in the primary key field of two different records, a dialog box warns you not to do 
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that. Primary key fields prevent you from entering duplicate records. They also 
make queries more efficient. In a query, you tell Access what to look for in data-
base tables, Access searches through the tables, and the program assembles infor-
mation that meets the criteria. Primary key fields help Access recognize records 
and not collect the same information more than once in a query.

Social security numbers make good primary key fields because no two people have 
the same social security number. Invoice numbers and serial numbers also make 
excellent primary key fields. Returning to the sample baseball league database (refer 
to Figure  1-7), which fields in the Little League database tables are primary key 
fields? In the Teams table, Team Name can be the primary key field because no two 
teams have the same name. Division Number can also be a primary key field because 
divisions in the league are numbered and no two divisions have the same number.

The Players and Coaches database tables, however, present a problem when it 
comes to choosing a primary key field. Two players might have the same last 
name, which rules out Last Name as a primary key field. A brother and sister 
might have the same telephone number, which rules out a Telephone No. field. 
Because no field holds values that are certain to be different from record to record, 
I introduce fields called Player Number and Coach Number. For the purpose of this 
database, players and coaches are assigned numbers. (Chapter 2 in this minibook 
explains how Access can assign sequential numbers for you in a database table.)

Mapping the relationships between tables
If your database includes more than one table, you have to map how the tables 
relate to one another. Usually, relationships are formed between the primary key 
field in one table and the corresponding field in another, called the foreign key.  
Figure 1-8 shows the relationships between the tables in the Little League database. 
Because these tables are linked by common fields, you can gather information 
from more than one table in a query or report. Chapter 2 in this minibook takes up 
the subject of linking tables in more detail. For now, when you design your data-
base, consider how to connect the various tables with common fields.

FIGURE 1-8:  
Table 

relationships.
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       Building Your 
Database Tables    

        D  atabase tables are the building blocks of a database. They hold the raw 
data. Relationships among the tables permit you to query and generate 
reports from several diff erent tables. How well your database tables are put 

together and how accurately data is entered in the tables determine whether your 
database is a thing of beauty or a wilted fl ower. 

 This chapter explains how to create database tables and fi elds for the tables. It 
explains what primary key fi elds are and how primary key fi elds and indexed 
fi elds make it easier for Access to sort, search, and query a database. This chapter 
describes how to forge relationships among tables. Fasten your seatbelts. In this 
chapter, you fi nd numerous tips and tricks for making sure that data is entered 
accurately in your database tables.  

  Creating a Database Table 
 Raw data is stored in database tables (or in a single table, if you decide to keep 
all the data in one place). The fi rst and most important part of setting up a data-
base is creating the tables and entering the data. After you enter the data, you can 

Chapter 2

 IN THIS CHAPTER 

 »     Creating database tables  

 »   Using fi eld properties to make data 
entries more accurate  

 »   Indexing fi elds in a table  

 »   Forming relationships among tables    
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harass your database for information about the things and people your database 
keeps track of. If you haven’t done so already, read the sections in Chapter 1 of this 
minibook that pertain to storing information and designing a database before you 
create a database table. Chapter 1 of this minibook explains what database tables 
are and how to fashion a splendid one.

The business of creating a database table starts on the Create tab. As I explain in 
detail in the next few pages, Access offers three ways to create a database table:

»» Create the database table from scratch: Enter and format the fields one at 
a time on your own.

»» Get the help of a template: Get prefabricated fields assembled in a table. 
This is the way to go if you know Access well and you can modify database 
tables and table fields.

»» Import the database table from another database: This technique can be 
an enormous timesaver if you can recycle data that has already been entered 
in a database table in another Access database.

Creating a database table from scratch
Creating a table from scratch entails creating the table and then entering the fields 
one by one. After you open a database file, follow these steps to create a database 
table from scratch:

1.	 Go to the Create tab.

2.	 Click the Table Design button.

The Design window appears. From here, you enter fields for your database table.  
I hate to be like a City Hall bureaucrat who gives everybody the runaround, but I 
can’t help myself. Turn to “Entering and Altering Table Fields,” later in this chapter, 
to find out how to enter fields in a database table.

3.	 Click the Save button on the Quick Access toolbar.

The Save As dialog box appears.

4.	 Enter a descriptive name for your table and click OK.

Return to the Navigation pane and you see the name of the table you created. 
If you don’t believe me, click the Tables group to see the names of tables in 
your database.
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Creating a database table from a template
If you know your way around Access and know how to modify database tables, you 
can do worse than create a database table with a template. Access offers four tem-
plate types: Contacts (for storing contact addresses and phone numbers); Issues 
(for prioritizing issues); Tasks (for tracking projects, their status, and when they 
are due); and Users (for storing email addresses). As well as creating a table, 
Access creates ready-made queries, forms, and reports to go along with the table. 
After you create a table with a template, you can remove fields that you don’t 
want. Deleting fields is always easier than adding new ones.

Follow these steps to use a template to create a table (and accompanying queries, 
forms, and reports):

1.	 Close all objects if any objects are open.

To close an object, click its Close button or right-click its tab and choose Close 
on the shortcut menu.

2.	 On the Create tab, click the Application Parts button.

A drop-down list with options for creating forms and tables appears. (The 
tables are listed under “Quick Start.”)

3.	 Choose Contacts, Issues, Tasks, or Users.

If you have other tables in your database, a dialog box asks whether you want 
to create a relationship between the table you’re creating and another table.

4.	 Select the There Is No Relationship option button and click Create.

Later in this chapter, “Establishing Relationships among Database Tables” 
explains how to create relationships on your own. If you want to create these 
relationships now and you have the wherewithal to do it, select an option 
besides There Is No Relationship, choose a table on the drop-down list, and 
click the Next button to choose which field to forge the relationship with.

5.	 On the Navigation pane, right-click the name of the table you created 
and choose Design View (or click the Design View button in the lower-
right corner of the screen).

In Design view, you can see the names of the fields in the table. If the table 
contains fields you don’t want or you want to change the names of the fields, 
turn to “Entering and Altering Table Fields,” later in this chapter.
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Importing a table from another database
Few things are more tedious than entering records in a database table. If the 
records you need were already entered elsewhere, more power to you. Follow 
these steps to get a database table from another Access database:

1.	 Go to the External Data tab.

2.	 Click the New Data Source button, choose From Database on the drop-
down list, and choose Access on the sublist.

The Get External Data – Access Database dialog box opens.

3.	 Click the Browse button, and in the File Open dialog box, select the 
Access database with the table you need and click Open.

You return to the Get External Data – Access Database dialog box.

4.	 Select the first option button (Import Tables, Queries, Forms, Reports, 
Macros, and Modules into the Current Database) and click OK.

You see the Import Objects dialog box, as shown in Figure 2-1.

5.	 On the Tables tab, select the database table you want.

You can import more than one database table by clicking several table names 
or clicking the Select All button.

FIGURE 2-1:  
Fetching a table 

from another 
database.
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You can import a table structure — its field names and formats — without 
importing the data in the table. To do so, click the Options button in the Import 
Objects dialog box, and under Import Tables, select the Definition Only option 
button (refer to Figure 2-1).

6.	 Click OK.

If the table you want to import includes lookup fields, import the tables or queries 
that the lookup fields refer to as well as the table itself. Without those tables or 
queries, the lookup fields won’t be able to obtain any values. Later in this chapter, 
“Creating a lookup data-entry list” explains what lookup fields are.

Opening and Viewing Tables
To open a table, start in the Navigation pane and select the Tables group to view 
the names of database tables you created. How you open a table depends on 
whether you want to open it in Datasheet view or Design view. Here’s the differ-
ence between these views (see Figure 2-2):

FIGURE 2-2:  
A table in Design 

view (top) and 
Datasheet view 

(bottom).
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»» Datasheet view is for entering and examining data in a table.

»» Design view is for creating fields and describing their parameters.

Select a table on the Navigation pane and use one of these techniques to open and 
view it:

»» Opening in Design view: Right-click the table’s name in the Navigation pane 
and choose Design View on the shortcut menu.

»» Opening in Datasheet view: On the Navigation pane, double-click the table’s 
name or right-click its name and choose Open on the shortcut menu.

»» Switching between views with the View button: On the Home tab, click the 
View button and choose Datasheet View or Design View.

»» Switching between views on the status bar: Click the Datasheet View or 
Design View button on the right side of the status bar (refer to Figure 2-2).

»» Switching between views by right-clicking: Right-click the table’s tab and 
choose Datasheet View or Design View.

Entering and Altering Table Fields
After you create a database table, the next task is to enter the fields, or if Access 
created the table for you, alter the fields to your liking. As Chapter 1 of this mini-
book explains, fields represent categories of information in a database table. They 
are the equivalent of columns in a conventional table. Fields determine what kind 
of information is stored in a database table.

These pages explain how to create a field, choose the right data type, display data 
in fields, and designate the primary key field in a table. While I’m on the subject 
of fields, W.C. Fields said, “Horse sense is the thing a horse has which keeps it 
from betting on people.”

Creating a field
Create a field on your own or get Access’s help and create a ready-made field. Both 
techniques are described here. Ready-made fields include fields designed espe-
cially for storing currency data, hyperlinks, and date information.
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Creating a field on your own
To create a field on your own, open the table that needs a new field and follow 
these steps on the (Table Tools) Design tab:

1.	 Switch to Design view if you aren’t already there.

To switch to Design view, click the Design View button on the status bar.

2.	 If necessary, insert a new row for the field.

To do so, click in the field that is to go after the new field, and then click the 
Insert Rows button on the (Table Tools) Design tab.

3.	 Enter a name in the Field Name column.

Names can’t include periods or be longer than 64 letters, but you don’t want to 
enter a long name anyway because it won’t fit very well along the top of the table.

Some database programs don’t permit spaces in field names. If you intend to 
export Access data to other database programs, don’t include spaces in field 
names. Instead, run the words together or separate words with an underscore 
character, like this: underscore_character.

4.	 Press the Tab key or click in the Data Type column, and choose a data 
type from the drop-down list, as shown in Figure 2-3.

Data types classify what kind of information is kept in the field. The next topic 
in this chapter, “All about data types,” explains data types.

FIGURE 2-3:  
Choosing a  

data type.
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5.	 If you want, enter a description in the Description column.

These descriptions can be very helpful when you need to reacquaint yourself 
with a field and find out what it’s meant to do.

In case the name you choose for your field isn’t descriptive enough, you can give 
the field a second name. The name appears in Datasheet view, on forms, and on 
reports. To enter a second, descriptive field name, enter the name in the Caption 
field on the General tab of the Design view window.

Later in this chapter, “Field Properties for Making Sure That Data Entries Are 
Accurate” demonstrates how to define field properties in the Design view window 
to make it easier for data-entry clerks to enter the data.

Taking advantage of ready-made fields
You can get a head start creating a field by using a ready-made field and then 
modifying it, if necessary. To create a ready-made field, switch to Datasheet view 
and select the field that you want your new field to go after. Then, on the (Table 
Tools) Fields tab, click a field button or click the More Fields button and choose 
the name of a field on the drop-down list.

Look for field buttons in the Add & Delete group. Field buttons include Short Text, 
Number, and Currency. After you create your new field, switch to Design view and 
examine its field properties. Some of these properties may need modifying. See 
“Field Properties for Making Sure That Data Entries Are Accurate” for information 
about field properties.

All about data types
To choose a data type for a field, open the Data Type drop-down list in the Design 
view window and choose a data type (refer to Figure 2-3). Data types are the first 
line of defense in making sure that data is entered correctly in a table. Try to enter 
text in a field assigned the Currency or Number data type, and Access tells you that 
your entry is invalid. You get the chance to fix your mistake as soon as you make it.

Table  2-1 explains the options on the Data Type drop-down list. Choose data 
types carefully because how you classify the data that is entered in a field deter-
mines how you can query the field for information. Querying for a number range 
is impossible, for example, if the field you’re querying isn’t classified as a Number 
or Currency field on the Data Type drop-down list.
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Designating the primary key field
As I explain in Chapter 1 of this minibook, no database table is complete without a 
primary key field. The primary key field identifies which field in the table is unique 
and contains data that differs from record to record. Duplicate values and null 
values can’t be entered in the primary key field. (A null value indicates a missing or 
unknown value.) Choosing a primary key field is so important that Access doesn’t 
let you close a table unless you choose one.

TABLE 2-1	 Data Types for Fields
Data Type What It’s For

Short Text For storing text (city names, for example), combinations of text and numbers (street 
addresses, for example), and numbers that won’t be calculated or used in expressions 
(telephone numbers, ZIP codes, and social security numbers, for example). A Short Text 
field can be no longer than 255 characters.

Long Text For storing long descriptions. Fields assigned this data type can hold 65,535 characters, not 
that anyone needs that many.

Number For storing numbers to be used in calculations or sorting. (If you’re dealing with monetary 
figures, choose the Currency data type.)

Large Number For importing and linking to BigInt (big integer) data. This data type is for working with 
calculations involving extremely large numbers.

Date/Time For storing dates and times and being able to sort data chronologically or use dates and 
times in calculations.

Currency For storing monetary figures for use in calculations and sorting.

AutoNumber For entering numbers in sequence that will be different from record to record. Use 
the AutoNumber data type for the primary key field if no other field stores unique,  
one-of-a-kind data.

Yes/No For storing True/False, Yes/No, On/Off type data. Choose this data type to enter data with 
a check box in the field. When the box is selected, the data in the field is True, Yes, or On, 
for example.

OLE Object For embedding an OLE link in your Access table to another object — an Excel worksheet or 
Word document. (Consider the using the Attachment data type as well.)

Hyperlink For storing hyperlinks to other locations on the Internet or on the company intranet.

Attachment For storing an image, spreadsheet, document, chart, or other file. Attaching a file to a 
database table is similar to attaching a file to an email message. Attachments do not 
require as much disk space as OLE objects because they don’t require Access to store a 
bitmap image of the original file.

Calculated For entering a mathematical expression that uses data from other fields in the database table.

Lookup Wizard For creating a drop-down list with choices that a data-entry clerk can choose from when 
entering data. See “Creating a lookup data-entry list,” later in this chapter.
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If no field in your table holds one-of-a-kind data that is different from record to 
record, get around the problem with one of these techniques:

»» The AutoNumber data type: Create a new field, give it a name, choose 
AutoNumber from the Data Type drop-down list (refer to Figure 2-3), and 
make your new field the primary key field. This way, when you enter data, 

DECIDING HOW THE DATA IN FIELDS IS 
DISPLAYED
To decide how numbers, times, dates, currency values, and Yes/No data are displayed in 
fields, go to the General tab in the Field Properties part of the Design view and choose 
an option on the Format drop-down list. The display options are useful indeed. Choose 
the Currency format, for example, and you don’t have to enter the dollar signs or com-
mas when you enter a dollar figure in the field because the dollar sign and commas are 
entered for you.

Moreover, you can create a format of your own by entering these placeholder symbols 
in the Format text box:

•	@ (at symbol): A character or space is required. For example, @@@@-@@ inserts a 
hyphen between the first set of numbers and the second. You don’t have to enter 
the hyphen, only the text or numbers.

•	& (ampersand): A character or space is optional. For example, @@@@@-&&&& in a 
ZIP Code field tells Access that either entry is correct, a five-character ZIP code or 
the ZIP code that has five characters plus the four extra characters.

•	 > (right bracket): Displays all characters in the field as uppercase. Merely by enter-
ing this symbol in the Format text box, you can display all entries in the field as 
uppercase without the data-entry clerk’s having to hold down the Shift or Caps 
Lock key.

•	 < (left bracket): Displays all characters in the field as lowercase.
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Access enters a unique number to identify each record in the field. (To 
generate random numbers instead of sequential numbers in an AutoNumber 
field, go the General tab of the Design view window, open the New Values 
drop-down list, and choose Random instead of Increment.)

»» A multiple-field primary key: Combine two or more fields and designate 
them as the primary key. For example, if you’re absolutely certain that no two 
people whose names will be entered in your database table have the same 
name, you can make the First Name and Last Name fields the primary key. 
The problem with multiple-field primary keys, however, is that it takes Access 
longer to process them, and you run the risk of entering duplicate records.

Follow these steps on the (Table Tools) Design tab to designate a field in a data-
base table as the primary key field:

1.	 In Design view, select the field or fields you want to be the primary key.

To select a field, click its row selector, the small box to its left; Ctrl+click row 
selectors to select more than one field.

2.	 Click the Primary Key button.

A small key symbol appears on the row selector to let you know which field or 
fields are the primary key fields.

To remove a primary key, click its row selector and then click the Primary Key 
button all over again.

Moving, renaming, and deleting fields
Suppose that you need to move, rename, or delete a field. To do so, switch to 
Design view and follow these instructions:

»» Moving a field: Select the field’s row selector (the box to its left) and release 
the mouse button. Then click again and drag the selector up or down to a 
new location.

»» Renaming a field: Click in the Field Name box where the name is, delete the 
name that’s there, and type a new name.

»» Deleting a field: Click in the Field Name box, go to the (Table Tools) Design 
tab, and click the Delete Rows button. You can also right-click the field and 
choose Delete Rows on the shortcut menu.
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Field Properties for Making Sure That  
Data Entries Are Accurate

Unfortunately, entering the data in a database table is one of the most tedious 
activities known to humankind. And because the activity is so dull, people are 
prone to make mistakes when they enter data in a database table. One way to 
cut down on mistakes is to take advantage of the Field Properties settings on the 
General tab in the Design view window. Figure 2-4 shows the General tab.

These properties determine what can and can’t be entered in the different fields 
of a database table. Some of the settings are invaluable. The Field Size property, 
for example, determines how many characters can be entered in a field. In a State 
field where two-letter state abbreviations are to be entered, make the Field Size 
property 2 to be certain that no one enters more than two characters. If the major-
ity of people you’re tracking in an address database live in New York, enter NY in 
the Default Value property. That way, you spare data-entry clerks from having 
to enter NY the majority of the time. They won’t have to enter it because NY is 
already there.

The Lookup tab in the Field Properties part of the Design view window is for 
creating a data-entry drop-down list. It, too, is invaluable. If you happen to know 
that only four items can be entered in a field, create a drop-down list with the 
four items. That way, data-entry clerks can choose from a list of four valid items 
instead of having to enter the data themselves and perhaps enter it incorrectly. 
(See “Creating a lookup data-entry list,” later in this chapter.)

A look at the Field Properties settings
Especially if yours is a large database, you’re encouraged to study the field 
properties carefully and make liberal use of them. The Field Properties settings 
safeguard data from being entered incorrectly. Following is a description of the 

FIGURE 2-4:  
Establishing field 

properties.



Bu
ild

in
g 

Yo
ur

 D
at

ab
as

e 
Ta

bl
es

0004373566.INDD 517	 Trim size: 7.375 in × 9.25 in� May 17, 2019 9:01 AM

CHAPTER 2  Building Your Database Tables      517

different properties (listed here in the order in which they appear in the Design 
view window) and instructions for using them wisely. Which properties you can 
assign to a field depends on which data type the field was assigned.

Field Size
In the Field Size box for Text fields, enter the maximum number of characters 
that can be entered in the field. Suppose that the field you’re dealing with is ZIP 
code, and you want to enter five-number ZIP codes. By entering 5 in the Field Size 
text box, only five characters can be entered in the field. A sleepy data-entry clerk 
couldn’t enter a six-character ZIP code by accident.

For Number fields, select a value for the field size from the drop-down list. 
Table 2-2 describes these field sizes.

The Single, Double, and Decimal field size options hold different ranges of num-
bers. For now, if you need to store numbers after the decimal point, choose the 
Double field size so that you cover most situations.

Format
Earlier in this chapter, “Deciding how the data in fields is displayed” (a sidebar) 
explains the Format property. Click the drop-down list and choose the format in 
which text, numbers, and dates and times are displayed.

TABLE 2-2	 Numeric Field Sizes
Field Size Description

Byte An integer that holds values from 0–255.

Integer An integer that holds values from –32,768– +32,767.

Long Integer An integer that holds values from –2,147,483,648– +2,147,483,647.

Single A floating point number that holds large values up to 7 significant digits.

Double A floating point number that holds large values up to 15 significant digits.

Replication ID* A globally unique identifier (GUID) required for replication; this number is 
generated randomly.

Decimal A number with defined decimal precision. The default precision is 0, but you can set the 
scale up to 28.

*Not supported by the .accdb file format.
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Decimal Places
For a field that holds numbers, open the Decimal Places drop-down list and 
choose how many numbers can appear to the right of the decimal point. This 
property affects how numbers and currency values are displayed, not their real 
value. Numbers are rounded to the nearest decimal point. The Auto option dis-
plays the number of decimal places permitted by the format you chose on the 
Format drop-down list.

Input Mask
For Text and Date field types, this feature provides a template with punctuation 
marks to make entering the data easier. Telephone numbers, social security num-
bers, and other numbers that typically are entered along with dashes and paren-
theses are ideal candidates for an input mask (another ridiculous database term!). 
On the datasheet, blank spaces appear where the numbers go, and the punctuation 
marks stand at the ready to receive numbers, as shown in Figure 2-5.

In the Input Mask text box, enter a 0 where numbers go and enter the punctua-
tion marks where they go. For example, enter (000) 000-0000 or 000/000-0000 
to enter an input mask for a telephone number like the one shown in Figure 2-5. 
You can also create input masks by clicking the three dots beside the Input Mask 
text box. Doing so opens the Input Mask Wizard dialog box, where you can fashion 
a very sophisticated input mask.

Caption
If the field you’re working on has a cryptic or hard-to-understand name, enter a 
more descriptive name in the Caption text box. The value in the Caption property 
appears as the column heading in Datasheet view, as a label on forms, and on 
reports in place of the field name. People entering data understand what to enter 
after reading the descriptive caption.

FIGURE 2-5:  
Input masks 

make data entry 
easier.
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Default Value
When you know that the majority of records require a certain value, number, or 
abbreviation, enter it in the Default Value text box. That way, you save yourself the 
trouble of entering the value, number, or abbreviation most of the time because 
the default value appears already in each record when you enter it. You can always 
override the default value by entering something different.

Validation Rule
As long as you know your way around operators and Boolean expressions, you 
can establish a rule for entering data in a field. For example, you can enter an 
expression that requires dates to be entered in a certain time frame. Or you can 
require currency figures to be above or below a certain value. To establish a vali-
dation rule, enter an expression in the Validation Rule text box. To use dates in 
an expression, the dates must be enclosed by number signs (#). Here are some 
examples of validation rules:

>1000 The value you enter must be over 1,000.

<1000 The value you enter must be less than 1,000.

>=10 The value you enter must be greater than or equal to ten.

<>0 The value you enter cannot be zero.

>=#1/1/2019# The date you enter must be January 1, 2019, or later.

>=#1/1/2019# And 
<#1/1/2020#

The date you enter must be in the year 2019.

To get help forming expressions, click the three dots beside the Validation Rule 
text box to open the Expression Builder, as shown in Figure 2-6, and build an 
expression there. Try clicking the Help button in the Expression Builder dialog 
box. Doing so opens the Access Help program, where you can get advice about 
building expressions.

Validation Text
If someone enters data that violates a validation rule that you enter in the Valida-
tion Rule text box, Access displays a standard error message. The message reads, 
“One or more values are prohibited by the validation rule set for [this field]. Enter 
a value that the expression for this field can accept.” If this message is too cold 
and impersonal for you, you can create a message of your own for the error mes-
sage dialog box. Enter your friendly message in the Validation Text text box.
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Required
By default, no entry has to be made in a field, but if you choose Yes instead of No 
in the Required box and you fail to make an entry in the field, a message box tells 
you to be sure to make an entry.

Allow Zero Length
This property allows you to enter zero-length strings in a field. A zero-length 
string — two quotation marks with no text or spaces between them (“”) — indi-
cates that no value exists for a field. To see how zero-length strings work, sup-
pose that your database table calls for entering email addresses. If you didn’t know 
whether one person has an email address, you would leave the E-Mail Address 
field blank. If, however, you knew that the person didn’t have an email address, 
you could indicate as much by entering a zero-length string. Choose Yes on the 
drop-down list to permit zero-length strings to be entered in the field.

Indexed
This property indicates whether the field has been indexed. As “Indexing for 
Faster Sorts, Searches, and Queries” explains, later in this chapter, indexes make 
sorting a field and searching through a field go faster. The word No appears in this 
text box if the field has not been indexed.

Unicode Expression
Choose Yes from the Unicode Expression drop-down list if you want to com-
press data that is now stored in Unicode format, which is a standardized encoding 

FIGURE 2-6:  
Creating a 

validation rule.
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scheme. Storing data this way saves on disk space, and you probably don’t want 
to change this property.

Smart Tags
If you intend to enter Smart Tags in the field, indicate which kind you enter by 
clicking the three dots next to the Smart Tags box and choosing an option in the 
Action Tags dialog box.

Text Align
This property determines how the text is aligned in a column or on a form or 
report. Select General to let Access determine the alignment, or select Left, Right, 
Center, or Distribute.

Text Format
Available on Long Text fields, this drop-down list lets you choose to allow rich 
text in the field. With this property set to Rich Text, you can make different words 
bold, italic, underline, and change font sizes and colors. Set it to Plain Text for 
plain, boring text with no formatting. I wonder why that isn’t the setting’s name.

Append Only
Available on Long Text fields, this property lets you add data only to a Long Text 
field to collect a history of comments.

Show Date Picker
This property is available on Date/Time fields. Choose For Dates to place a button 
next to the column that data-entry clerks can click to open a calendar and select a 
date instead of typing numbers.

IME Mode/IME Sentence mode
These options are for converting characters and sentences from East Asian ver-
sions of Access.

Creating a lookup data-entry list
Perhaps the best way to make sure that data is entered correctly is to create a 
data-entry drop-down list. That way, anyone entering the data in your database 
table can do so by choosing an item from the list, not by typing it in, as shown in 
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Figure 2-7. This method saves time and prevents invalid data from being entered. 
Access offers two ways to create the drop-down list:

»» Create the list by entering the items yourself: Go this route when you’re 
dealing with a finite list of items that never change.

»» Get the items from another database table: Go this route to get items from 
a column in another database table. This way, you can choose from an 
ever-expanding list of items. When the number of items in the other database 
table changes, so does the number of items in the drop-down list because the 
items come from the other database table. This is a great way to get items 
from a primary key field in another table.

Creating a drop-down list on your own
Follow these steps to create a drop-down, or lookup, list with entries you type:

1.	 In Design view, click the field that needs a drop-down list.

2.	 Open the Data Type drop-down list and choose Lookup Wizard, the last 
option in the list.

The Lookup Wizard dialog box appears.

3.	 Select the second option, I Will Type in the Values That I Want, and click 
the Next button.

4.	 Under Col1 in the next dialog box, enter each item you want to appear in 
the drop-down list; then click the Next button.

You can create a multicolumn list by entering a number in the Number of 
Columns text box and then entering items for the list.

FIGURE 2-7:  
A so-called 
lookup list.
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5.	 Enter a name for the field, if necessary, and click the Finish button.

Switch to Datasheet view and open the drop-down list in the field to make sure 
that it displays properly.

To remove a lookup list from a field, select the field, go to the Lookup tab in 
the Design view window, open the Display Control drop-down list, and choose 
Text Box.

To see what’s on a drop-down list, select the field for which you created the list, 
switch to Design view, and select the Lookup tab in the Field Properties pane. As 
shown in Figure 2-8, you can edit the list by editing or removing items in the Row 
Source text box. Be sure that a semi-colon (;) appears between each item.

Getting list items from a database table
Before you can get list items from another database table, you might want to 
define a relationship between the tables; it’s not required, but it’s recommended. 
Later in this chapter, “Establishing Relationships among Database Tables” 
explains how to do that. Follow these steps to get items in a drop-down list from 
another database table:

1.	 In Design view, click the field that needs a list, open the Data Type 
drop-down list, and choose Lookup Wizard.

The Lookup Wizard dialog box appears.

2.	 Select the first option, I Want the Lookup Field to Get the Values from 
Another Table or Query, and click Next.

You see a list of tables in your database.

3.	 Select the table with the data you need and click the Next button.

The dialog box shows you a list of available fields in the table.

4.	 Select the field where the data for your list is stored.

FIGURE 2-8:  
Lookup field 

properties.
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5.	 Click the > button.

The name of the list appears on the right side of the dialog box, under Selected 
Fields.

6.	 Click the Next button.

Normally, lists are displayed in ascending order, but you can select a field and 
click the Ascending button to reverse the order of the list. (Note that the button 
turns into the Descending button.)

7.	 Click the Finish button.

If you’re so inclined, you can change the width of the list before clicking Finish, 
but you can always do that on the datasheet, as Chapter 3 of this minibook 
explains.

Suppose that you obtain the items from the wrong field or wrong database table. 
To fix that problem, select the field for which you created the list, and in Design 
view, select the Lookup tab (refer to Figure  2-8). Choose Text Box instead of 
Combo Box on the Display Control drop-down list and start all over.

Indexing for Faster Sorts,  
Searches, and Queries

Indexing means to instruct Access to keep information about the data in a field or 
combination of fields. Because Access keeps this information on hand, it doesn’t 
have to actually search through every record in a database table to sort data, search 
for data, or run a query. In a large database table, indexes make sorting, search-
ing, and querying go considerably faster because Access looks through its own 
data rather than the data in tables. The performance difference between querying 
a database table that has and has not been indexed is astonishing. That’s the good 
news. The bad news is that indexes inflate the size of Access files.

By default, the field you choose as the primary key field is indexed. I recommend 
choosing other fields, in addition to the primary key field, for indexing if you often 
conduct queries and searches. When you choose a field to index, choose one with 
data that varies from record to record and is likely to be the subject of searches, 
sorts, and queries. That way, the index means something. However, a field with 
data that is mostly the same from record to record is a waste of a good index, 
not to mention disk space. By the way, Access automatically indexes fields whose 
names include the words ID, Code, Num, and Key, the idea being that these fields are 
likely to store essential information worthy of indexing.
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Indexing a field
To index a field, switch to Design view, select the field you want to index, and 
on the General tab of the Field Properties part of the Design window, open the 
Indexed drop-down list and choose one of these options:

»» Yes (Duplicates OK): Indexes the field and allows duplicate values to be 
entered in the field.

»» Yes (No Duplicates): Indexes the field and disallows duplicate values. If you 
choose this option, the field works something like a primary key field in that 
Access does not permit you to enter the same value in two different records.

Indexing based on more than one field
An index created on more than one field is called a multifield index. Multifield 
indexes make sorting, querying, and searching the database table go faster. They 
are especially valuable in sorting operations where records in one field are usually 
the same but records in a companion field are different. In a large database table 
that stores names and addresses, for example, many names in the Last Name field 
are the same, so indexing on the Last Name field isn’t worthwhile, but indexing 
the First Name and Last Name fields helps Access distinguish records from one 
another.

Follow these steps to generate a multifield index:

1.	 Switch to Design view, and on the (Table Tools) Design tab, click the 
Indexes button.

You see the Indexes dialog box, as shown in Figure 2-9. The dialog box lists the 
primary key field already because it’s indexed by default. You also see any 
fields to which you set the Indexed property to Yes.

2.	 On a blank line in the dialog box, enter a name for the index in the Index 
Name column.

3.	 In the Field Name column, open the drop-down list and choose the first 
field you want for the multifield index.

Access sorts the records first on this field and then on the second field you 
choose.

4.	 In the next row, leave the Index Name blank and choose another field 
name from the drop-down list.

This field is the second field in the index. You can use as many as ten different 
fields in a multifield index. In Figure 2-9, two fields are in a multifield index: 
First Name and Last Name.
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5.	 Choose Descending in the Sort Order column if you want the field sorted 
in descending order.

Most of the time, you want leave the Sort Order set to Ascending because most 
people read from A to Z.

6.	 Click the Close button.

Click the Indexes button in Design view if you need to return to the Indexes 
dialog box and change how fields are indexed.

Establishing Relationships among 
Database Tables

As Chapter 1 of this minibook explains, you have to establish relationships among 
tables if you want to query or generate reports with data from more than one 
database table. Relationships define the field that two different tables have in 
common. To understand why relationships between tables are necessary, consider 
the query shown in Figure 2-10. The purpose of this query is to list all companies 
that ordered items in 2019, list the companies by name, and list the city where 
each company is located.

Consider what Access does to run this query:

»» Access deals with two database tables, Customers and Orders.

»» In the Orders table, Access looks in the Order Date field to isolate all records 
that describe orders made in the year 2019. The expression for finding these 
records is shown on the Criteria line in Figure 2-10: Between #1/1/2019# 
And #12/31/2019#.

FIGURE 2-9:  
The Indexes 

dialog box.
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»» Because a relationship exists between the ID field in the Customers table and 
the Customer ID field in the Orders table — that is, the two fields hold the 
same type of information — Access can match the 2019 records it finds in the 
Orders table with corresponding records in the Customers table. Where the 
Customer ID of a 2019 record in the Orders table and an ID in the Customers 
table match, Access assembles a new record and places it in the query results.

»» Data for determining which records appear in the query results is found in the 
Order Date field in the Orders table. But the information compiled in the 
query results — customer IDs, company names, and cities — comes from 
fields in the Customers table. Thanks to the relationship between the ID and 
Customer ID fields in these tables, Access can draw upon information from 
both tables.

FIGURE 2-10:  
To conduct 

a query with 
more than one 

table, the tables 
must have a 
relationship.
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Types of relationships
The vast majority of relationships between tables are one-to-many relationships 
between the primary key field in one database table and a field in another. Table 
relationships fall in these categories:

»» One-to-many relationship: Each record in one table is linked to many 
records in another table. The relationship in Figure 2-10 is a one-to-many 
relationship. Each ID number appears only once in the ID field of the 
Customers table, but in the Orders table, the same Customer ID number can 
appear in many records because the same customer can order many 
different products. When you link tables, Access creates a one-to-many 
relationship when one of the fields being linked is either a primary key field or 
an indexed field that has been assigned the No (No Duplicates) setting. (See 
“Indexing for Faster Sorts, Searches, and Queries,” earlier in this chapter.)

»» One-to-one relationship: Two fields are linked. This relationship is rare and 
is sometimes used for security purposes.

»» Many-to-many relationship: This complex relationship actually describes 
crisscrossing relationships in which the linking field is not the primary key field 
in either table. To create a many-to-many relationship, an intermediary table 
called a junction table is needed. This relationship is rare.

Sometimes, fields in separate tables that hold the same data also have the same 
name, but that isn’t necessary. For example, a field called ZIP Code in one table 
might be called Postal Code in another. What matters is that fields that are linked 
have the same data type. For example, you can’t create a relationship between a 
text field and a number field.

Handling tables in the Relationships 
window
To display the tables in a database and link tables to one another or see how 
they’re related to each other, go to the Database Tools tab and click the Relation-
ships button. You see the Relationships window, as shown in Figure 2-11. Notice 
the field names in each table. The primary key field is shown with a picture of a 
key next to it. Lines in the window show how relationships have been established 
between tables.
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PLACING TABLES IN THE RELATIONSHIPS 
WINDOW
The first time you open the Relationships window, you see the Show Table dialog box. 
Use this dialog box to tell Access which tables to put in the Relationships window. 
Ctrl+click to select tables and then click the Add button.

If you create a new database table and want to place it in the Relationships window, 
click the Relationships button to display the Relationships window; then click the 
Show Table button on the (Relationship Tools) Design tab. The Show Table dialog box 
appears. Select your new table and click the Add button.

FIGURE 2-11:  
The Relationships 

window.
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Apart from linking tables in the Relationships window (a subject I explain shortly), 
use these techniques on the (Relationship Tools) Design tab to handle tables:

»» Repositioning and resizing the tables: Each table appears in its own 
window. Drag tables from place to place, drag a border to change a window’s 
size, and scroll to see field names.

»» Removing a table from the window: Select the table and click the Hide 
Table button.

»» Removing all tables from the window: Click the Clear Layout button and 
choose Yes in the confirmation box.

»» Placing tables back on the window: Click the Show Table button, and in the 
Show Table dialog box, select the tables and click the Add button.

»» Placing all tables back in the window: To put all the tables with relation-
ships back in the window, click the All Relationships button.

»» Studying a table’s relationships: Click the Clear Layout button to remove all 
tables from the window; then place the table back in the window, select it, and 
click the Direct Relationships button. All tables that are related to the selected 
table are added to the layout.

To generate and print an Access report that shows how tables in your database are 
linked, go to the (Relationship Tools) Design tab and click the Relationship Report 
button. Then save the report and print it. Chapter  5 of this minibook explains 
reports.

Forging relationships between tables
On the (Relationship Tools) Design tab (refer to Figure 2-11), make sure that both 
tables are on display and then follow these steps to forge a relationship between 
them:

1.	 Click to select the field in one table; then hold down the mouse button, 
drag the pointer to the field in the other table where you want to forge 
the link, and release the mouse button.

You see the Edit Relationships dialog box, as shown in Figure 2-12. This 
dragging between table fields is probably the most awkward thing you 
undertake in Office 365! If you do it right, a bar appears where the pointer is 
while you move it over the second table, and the names of the two fields 
appear in the Edit Relationships dialog box.
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Notice the Relationship Type at the bottom of the dialog box. If you accidentally 
create a link to the wrong field, choose the correct field from the drop-down 
list in the dialog box.

2.	 Select the Enforce Referential Integrity check box.

If you don’t select this box, the relationship between the tables is indetermi-
nate, instead of being a one-to-many relationship. Referential integrity (another 
hideous database term!) has to do with whether values in the two different 
fields corroborate each other.

3.	 Select Cascade options if you so choose.

One of these options is excellent; the other is dangerous:

•	 Cascade Update Related Fields: If you change a value on the “one” side  
of the relationship, a matching value on the “many” side changes as well to 
preserve referential integrity. For example, if you create a multifield 
primary key of First Name and Last Name and then change the name of 
someone, the related fields in the other table change automatically to 
preserve referential integrity. This is a great way to make sure that 
information is up to date.

•	 Cascade Delete Related Records: If you delete a record in the “one” table, 
all records in the “many” table to which the deleted record is linked are also 
deleted. For example, if you delete an employee from the “one” table, all 
records in the “many” table that include that employee are deleted! Access 
warns you before making the deletion, but still! This option is dangerous, 
and I don’t recommend selecting it.

4.	 Click the Create button to forge the relationship.

In the Relationships window (refer to Figure 2-11), a line is drawn between the 
table fields. The number 1 appears on the “one” side of the relationship and 
the infinity symbol (∞) appears on the “many” side.

FIGURE 2-12:  
Creating a table 

relationship.
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After you create a one-to-many relationship between tables with the Enforce Ref-
erential Integrity check box selected, you can’t enter a value in the “many” table 
unless it’s already in the “one” table. For example, suppose that the “one” table 
includes a primary key field called Employee Number, and this field is linked to 
a field in the “many” table that is also called Employee Number. If you enter an 
Employee Number in the “many” table that isn’t in the “one” table, Access warns 
you that it can’t be done without violating referential integrity. The best way to 
solve this problem is to create a lookup data-entry list in the “many” table with 
values from the primary key field in the “one” table. See “Creating a lookup data-
entry list,” later in this chapter.

Editing table relationships
In the Relationships window (refer to Figure 2-11), select the line that represents 
the relationship between two database tables and follow these instructions to edit 
or remove the relationship:

»» Editing the relationship: Click the Edit Relationships button or right-click 
and choose Edit Relationship. You see the Edit Relationships dialog box, 
where you can overhaul the relationship. (The previous topic in this chapter 
explains how.)

»» Deleting the relationship: Press the Delete key or right-click and choose 
Delete. Then select Yes in the confirmation box.
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       Entering the Data       

 A  t last — you can start entering the data. If you set up your database tables, 
named the fi elds, and established relationships between the tables, you’re 
ready to go. This short chapter explains how to enter the data in a database 

table. It shows you how to enter data on a datasheet or enter data by way of a form. 
This chapter also describes how to fi nd missing records in case one goes astray. 

 There’s no getting around it: Entering data is truly a tedious activity. But if you set 
up the fi elds well and take advantage of input masks and other fi eld properties, it 
isn’t so bad. It’s better than stepping on a shovel blade, anyway.  

  The Two Ways to Enter Data 
 When it comes to entering data in a database table, you can take your pick between 
Datasheet view and a form. Figure   3-1   compares and contrasts the two. Here are 
the advantages of entering data in Datasheet view:

 »   Many records appear simultaneously. 

 »  You can compare data easily between records. 

 »  You can sort by column with the commands in the Sort and Filter group on 
the Home tab (as discussed in Chapter 4 of this minibook). 

 »  You can scroll up or down to locate records.   

Chapter 3

    IN THIS CHAPTER 

 »     Entering data on a datasheet  

 »   Changing the look of a datasheet  

 »   Creating a form for entering data  

 »   Finding and replacing your data     
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Here are the advantages of entering the data in a form:

»» You don’t have to scroll left or right to see all the fields.

»» Getting from field to field is easier.

»» Fields are clearly labeled so that you always know what to enter.

Entering the Data in Datasheet View
Entering data in Datasheet view is like entering data in a conventional table. As 
with a table, a datasheet has columns and rows. Records are entered in rows, and 
each column represents a field. Fans of Datasheet view like being able to look at 
a dozen records simultaneously. For fans of Datasheet view, these pages explain 
how to enter data in a datasheet and change a datasheet’s appearance.

FIGURE 3-1:  
Entering records 

in Datasheet view 
(left) and in a 
form (right).
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Database tables open in Datasheet view when you double-click their names in the 
Navigation pane. But if you happen to be gazing at a table in Design view, click the 
View command on the Home tab or the Datasheet View button on the status bar.

Entering data
In Datasheet view, the bottom of the window tells you how many records are 
entered in the database table and which record the cursor is in. To enter a new 
record, move to a new, empty row and start entering the data. To create a new 
row, do one of the following:

»» On the Home tab, click the New button.

»» Click the New (Blank) Record button in the Datasheet navigation buttons. 
These buttons are located in the bottom-left corner of the Datasheet view 
window.

»» Scroll to the bottom of the Datasheet view window and begin typing in the 
row with an asterisk (*) next to it.

»» Press Ctrl++ (the plus key).

A pencil icon appears on the row selector to let you know which record you’re 
dealing with. To get from field to field, click in a field, press the Tab key, or press 
Enter. Table 3-1 lists keyboard shortcuts for getting around in a datasheet.

TABLE 3-1	 Datasheet Shortcuts
Press. . . To Move. . .

↑ To the previous record. You can also press the Previous button on the Navigation buttons.

↓ To the next record. You can also press the Next button.

Tab or Enter To the next field in the record.

Shift+Tab To the previous field in the record.

Home To the first field in the record.

End To the last field in the record.

Ctrl+Home To the first field in the first record. You can also press the First button.

Ctrl+End To the last field in the last record. You can also press the Last button.

Page Up Up one screen.

Page Down Down one screen.
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To delete a record, click its row selector and press the Delete key or the Delete 
button (located on the Home tab). You can also click in a record, go to the (Table 
Tools) Fields tab, and click the Delete button there. After you delete a record, it is 
gone forever. You can’t resuscitate it.

Two tricks for entering data quicker
In a database table with many fields, it’s sometimes hard to tell what data to 
enter. When the pointer is in the sixth or seventh field, for example, you can lose 
sight of the first field, the one on the left side of the datasheet that usually identi-
fies the person or item whose record you’re entering.

To freeze a field so that it appears onscreen no matter how far you travel toward 
the right side of the datasheet, right-click the field’s column heading and choose 
Freeze Fields on the shortcut menu. To unfreeze the fields, right-click the column 
heading and choose Unfreeze All Fields on the shortcut menu. You can freeze more 
than one field by dragging across field names at the top of the datasheet before 
choosing to freeze the columns. Is it getting cold in here?

ENTERING DATA IN THE ZOOM BOX
To make putting a long entry in a field a little easier, Access offers the Zoom box. Instead 
of having to stay within the narrow confines of a datasheet field, you can press Shift+F2 
to open the Zoom box and enter the data there. After you click OK, the data is entered in 
the field.

The Zoom box is especially convenient for entering data in a Memo field. As Chapter 2 
in this minibook explains, Memo fields can hold a whopping 65,535 characters. Move 
the cursor into a field and press Shift+F2 to open the Zoom box and read all the text 
in the field.
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Another way to handle the problem of not being able to identify where data is 
supposed to be entered is to hide columns in the datasheet. To perform this trick, 
select the columns you want to hide by dragging the pointer across their names; 
then right-click the column heading and choose Hide Fields on the shortcut menu. 
To see the columns again, right-click any column heading and choose Unhide 
Fields on the shortcut menu. You see the Unhide Columns dialog box. Select the 
fields that you want to see on the datasheet.

The fastest way to hide a column is to drag the border between it and the next 
column to the left until the column disappears.

Changing the appearance of the datasheet
To make the datasheet a little less cluttered and unwieldy, try experimenting with 
its appearance. Access offers a few handy shortcuts for doing just that:

»» Rearranging columns: To move a column to a different location, click its 
name at the top of the datasheet and drag it to the left or right.

»» Resizing columns: Move the pointer between column names at the top of  
the datasheet, and when you see the double-headed arrow, click and start 
dragging. To make a column just large enough to fit its widest entry, move the 
pointer between column names and double-click when you see the double-
headed arrow.

»» Changing fonts: The default font for a datasheet is Calibri 11-point, but the 
Home tab offers commands for changing fonts and font sizes. Look for these 
commands in the Text Formatting group.

»» Changing the look of gridlines: On the Home tab, open the drop-down list 
on the Gridlines button and choose options to change the number and 
thickness of gridlines.

»» Alternate row colors: On the Home tab, open the drop-down list on the 
Alternate Row Color button and choose a color for alternating rows on the 
datasheet.

To experiment all at one time with the many options for changing a datasheet’s 
appearance, go to the Home tab and click the Text Formatting group button. You 
see the Datasheet Formatting dialog box, as shown in Figure 3-2. If you want a 
customized look for all the datasheets you work on, visit the File tab and select 
Options. Then go to the Datasheet category in the Options dialog box and go to 
town.
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Entering the Data in a Form
Forms like the one shown in Figure 3-3 are very convenient for entering data. The 
labels tell you exactly what to enter. Personally, I prefer entering data in a form 
to entering data on a datasheet. On a form, you take it one step — make that one 
record — at a time. Not looking at a dozen records makes the task of entering data a 
little easier. These pages explain how to create a form for entering information in a 
database table. You also get advice for moving around with the Navigation buttons.

Creating a form
Fortunately, the Form Wizard makes it very simple to create a form for entering 
information in a database table. All you have to do is start the wizard, choose the 
table, and make a couple of design decisions. To create a form, go to the Create tab 
and click the Form Wizard button. You see the first of several Form Wizard dialog 
boxes. Answer these questions and keep clicking the Next button until the time 
comes to click Finish:

»» Tables/Queries: From the drop-down list, choose the name of the database 
table you need to enter data in.

»» Selected Fields: Click the >> button to enter all the field names in the Select 
Fields box.

»» Layout: Select the Columnar option button. The other layouts aren’t much 
good for entering data in a table. If you choose Tabular or Datasheet, you may 
as well enter data straight into the datasheet rather than rely on a form.

»» Title: Name your form after the table you created it for so that you can 
identify the form easily in the Navigation pane.

FIGURE 3-2:  
The Datasheet 

Formatting 
dialog box.
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To delete a form, right-click its name in the Navigation pane and choose Delete 
on the shortcut menu.

Entering the data
To open a form and begin entering data in its database table, display the form’s 
name in the Navigation pane and then double-click the form’s name. You can also 
right-click the name of the form and choose Open.

To enter data in a form, click the New (Blank) Record button. This button is 
located with the Navigation buttons at the bottom of the form window. A new, 
empty form appears. Start typing. Press the Tab key, press the Enter key, or click 
to move from field to field. You can move backward through the fields by pressing 
Shift+Tab. If you enter half a record and want to start over, press the Esc key to 
empty the current field. Press Esc again to empty all the fields.

The Navigation buttons at the bottom of the form window tell you how many 
records are in the database table and which record you’re looking at. From left to 
right, the Navigation buttons take you to the first record, previous record, next 
record, and last record.

FIGURE 3-3:  
A form.
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Finding a Missing Record
Sometimes data goes astray. You scroll through a datasheet but simply can’t find 
the item or record you need so badly. For times like those, Access offers the Find 
command. Use the command to scour a database for errant information.

Open the database table with the data that needs finding. If you know in which 
field the data is located, click in the field. You can save a little time that way. 
Then, on the Home tab, click the Find button (or press Ctrl+F). You see the Find 
and Replace dialog box, as shown in Figure 3-4. Fill in the dialog box as follows:

»» Find What: Enter the item you’re looking for. If you’re looking for a null value, 
enter null in this text box. Enter “” (two double-quotation marks) to find 
zero-length strings. Table 3-2 describes the wildcard characters you can use 
in searches.

»» Look In: If you clicked in a field before choosing the Find command, Current 
Field is selected in this box. To search the entire database table, choose 
Current Document on the drop-down list.

»» Match: Choose the option that describes what you know about the item. 
Choosing the Any Part of Field option can make for a long search. For 
example, a search for the letters chin finds, among others, China, Ching, 
and itching — any word with the consecutive letters chin.

»» Search: Choose an option — All, Up, or Down — that describes which 
direction to start searching.

»» Match Case: If you know the combination of upper- and lowercase letters 
you’re after and you enter the combination in the Find What text box, select 
this check box.

»» Search Fields As Formatted: If you’re searching for a field that has been 
formatted a certain way, select this check box and make sure that the text or 
numbers you enter in the Find What text box are formatted correctly. For 
example, if you’re searching for a record with the date July 31, 1958, and you 
choose the mm/dd/yyyy format, enter the date as 07/31/1958.

FIGURE 3-4:  
Finding data.
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Click the Find Next button to conduct the search. The item might be found in more 
than one location. Keep clicking Find Next (or pressing Alt+F) until you find the 
item or you die of thirst on the hot sands of the digital desert.

To quickly find the first value of a search term, start typing in the Search box in 
the form window or in Datasheet view. As soon as you start typing, the cursor 
moves to the first instance of the data you enter. The search box is located at the 
bottom of the screen.

Finding and Replacing Data
Finding and replacing data is remarkably similar to finding data. The difference is 
that you enter data in the Replace With text box as well as the familiar Find What 
text box and other option boxes. Figure 3-5 shows the Replace tab of the Find and 
Replace dialog box. Does it look familiar? If it doesn’t, read the preceding topic in 
this chapter, “Finding a Missing Record.”

TABLE 3-2	 Wildcard Characters for Searches
Character Description Example

? A single character b?t finds bat, bet, bit, and but.

# A single numeric digit 9411# finds 94111, 94112, 94113, and so on.

* Any group of consecutive 
characters

t*o finds to, two, and tattoo.

[xyz] Any character in the brackets t[aio]pper finds tapper, tipper, and topper, but not tupper.

[!xy] Any character not in 
the brackets

p[!io]t finds pat and pet, but not pit and pot.

x–z Any character in a range of 
characters

[1–4]000 finds 1000, 2000, 3000, and 4000, but not 5000. The 
range must be in ascending order.

FIGURE 3-5:  
Replacing data.
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To find and replace data, go to the Home tab and click the Replace button (or press 
Ctrl+H). You see the Replace tab of the Find and Replace dialog box. After you enter 
the replacement data in the Replace With text box, make sure that Whole Field is 
selected in the Match drop-down list. Conducting a find-and-replace operation 
with Any Part of Field or Start of Field selected in the Match drop-down list can 
have unintended consequences. For example, a search for Brook also finds Brook-
lyn, Middlebrook, and other words that include brook. Blindly replacing the brook 
text string with stream produces, for example, Streamlyn and Middlestream.

Unless you’re as confident as a gambler with four aces, don’t click the Replace All 
button to replace all instances of the text or numbers in the database table or field 
you’re searching in. Instead, click the Replace button to find and replace text or 
numbers one instance at a time.

By the way, you can also find and replace data with an update query. Chapter 4 of 
this minibook covers update queries.
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       Sorting, Querying, and 
Filtering for Data       

 N  ow that you’ve laid the groundwork, you can put your database through its 
paces and make it do what databases are meant to do: provide informa-
tion of one kind or another. This chapter explains how to pester an Access 

database for names, addresses, dates, statistical averages, and whatnot. It shows 
how to sort records and fi lter a database table to see records of a certain kind. You 
also fi nd out how to query a database to get it to yield its dark secrets and inval-
uable information.  

  Sorting Records in a Database Table 
Sorting  rearranges records in a database table so that the records appear in alpha-
betical, numerical, or date order in one fi eld. By sorting the records in a database, 
you can locate records faster. What’s more, being able to sort data means that you 
don’t have to bother about the order in which you enter records because you can 
always sort them later to put them in a particular order. 

Chapter 4

    IN THIS CHAPTER 

 »     Sorting, or rearranging, records in a 
database table  

 »   Filtering records in a table to see only 
the records you need  

 »   Querying to collect and examine 
information stored in a database  

 »   Looking at diff erent kinds of queries     
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Ascending versus descending sorts
Records can be sorted in ascending or descending order:

»» Ascending order: Arranges records in alphabetical order from A to Z, 
numbers from smallest to largest, and dates chronologically from earliest 
to latest.

»» Descending order: Arranges text from Z to A, numbers from largest to 
smallest, and dates chronologically from latest to earliest.

Sorting records
Follow these steps to sort the records in a database table:

1.	 In Datasheet view, click anywhere in the field by which you want to sort 
the records.

2.	 On the Home tab, click the Ascending or Descending button.

You can also right-click a field name at the top of a column and choose Sort A 
to Z or Sort Z to A on the shortcut menu. The menu choices change based on 
the type of data. For Number fields, you can sort smallest to largest and vice 
versa; for Date fields, choose to sort oldest to newest, or vice versa.

You can sort on more than one field by clicking a field and sorting it, and then 
clicking a second field and sorting it. Just make sure you sort the fields in reverse 
order. For example, to sort the database by the Employee, Customer, and Order ID 
fields, click in Order ID and sort it in ascending order; click in Customer and sort 
it in ascending order; click in Employee and sort it in ascending order. If you mess 
up and forget how the table is sorted, click the Remove Sort button. This button 
is located on the Home tab underneath the Ascending and Descending buttons.

Filtering to Find Information
Filtering isolates all the records in a database table that have the same field values 
or nearly the same field values. Instead of all the records in the table appearing 
on the datasheet, only records that meet the filtering criteria appear, as shown in 
Figure 4-1.
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THE DIFFERENCE BETWEEN A FILTER  
AND A QUERY
The biggest difference between filtering and querying is that you can save a query and 
call upon it more than once. Queries are kept at the ready in the Navigation pane. A 
filter, on the other hand, is as good as the first time you use it, although you can save 
and run it as a query. Filters apply to a single database table, whereas you can query 
to assemble information from more than one table. In the results of a query, you can 
include as many fields as you want, but the results of a filtering operation show all the 
fields in the database table, regardless of whether you want them.

When it comes to examining data, a query is more sophisticated than a filter. Although 
you can use standard comparison operators to find records by filtering, querying gives 
you the opportunity to use complex expressions as well as comparison operators. You 
can filter, for example, to find people whose income is greater than or less than a cer-
tain amount. However, because you can write expressions in queries, you can query to 
find people whose income falls within a certain range.

FIGURE 4-1:  
Results of 
a filtering 

operation.
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The basic idea behind filtering is to choose a field value in the database table and 
use it as the standard for finding or excluding records. For example, you can find 
all the orders for a particular customer, all orders taken in the month of April, 
or all the orders that a particular customer placed in April. For that matter, you 
can filter by exclusion and see the records of all the orders in a database table not 
taken in April and not for a particular customer. Filtering is useful when you need 
to find records with specific information in a single database table.

Different ways to filter a database table
For comparison purposes, here are shorthand descriptions of the four ways to 
filter a database table. All filtering operations begin in Datasheet view on the 
Home tab. These techniques are described in detail in the upcoming pages.

»» Filter by Selection: Select all or part of a field in the database table, click the 
Selection button, and choose a filtering option. Access isolates all records with 
the data you select. This method works best when you can’t quite decide what 
you’re looking for. It’s the only filtering method that permits you to look for 
data found in a whole field or part of a field. You can also filter data that 
doesn’t match the selection.

»» Filter for Input: Select the field you want to filter with and click the Filter 
button. A dialog box appears so that you can choose values in the field or 
enter comparison operators to describe the numeric or date values you are 
filtering for. With this technique, you can filter for data ranges.

»» Filter by Form: Click the Advanced button and choose Filter by Form. You see 
a form with one drop-down list for each field in your table. From the drop-
down lists, make choices to describe the records you’re looking for and then 
click the Toggle Filter button. This method is more flexible than the others 
because you can conduct OR as well as AND filtering operations. For example, 
you can isolate the records of people named Smith who also live in California, 
or the people who live in California or New York.

»» Advanced Filter/Sort: Click the Advanced button and choose Advanced Filter/
Sort. The Filter window opens. Drag the name of the field you want to filter 
onto the grid. Then choose a Sort option and enter a search criterion. This 
filtering technique has more in common with queries than filters. Truth be 
told, the Advanced Filter/Sort command is merely a way to query a single 
table.

After you filter a database table, you can run a second (or third or fourth) filter 
operation to filter the data even more and further isolate the data you are look-
ing for.
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“Unfiltering” a database table
You can tell when you’re looking at a database table that has been filtered rather 
than a database table with all its records because the word Filtered appears at 
the bottom of the window next to the Navigation buttons (refer to Figure 4-1). 
Moreover, the filter icon appears in the field names of columns used in the filter 
operation and the Toggle Filter button on the Ribbon is highlighted.

When you finish filtering a database table, use one of these techniques to “unfilter” 
it and see all the records in the table again:

»» Click the word Filtered at the bottom of the window. You can click this word 
again or click the Toggle Filter button to repeat the filter operation.

»» On the Home tab, click the Toggle Filter button. You can click this button again 
to repeat the filter operation.

»» On the Home tab, click the Advanced button and choose Clear All Filters on 
the drop-down list. Choosing this option kills the filter operation; you can’t 
repeat it except by reconstructing it in the Datasheet window.

Filtering by selection
Filtering by selection is the fastest way to filter a database table. It’s also the 
best way when you’re not sure what you’re looking for because you can search for 
partial words and phrases. Follow these steps to filter by selection:

1.	 Display the database table that needs filtering in Datasheet view.

2.	 Tell Access how to filter the records.

To find all records with the same value or text in a particular field, simply click 
in a field with the value or text. If you aren’t quite sure what to look for, select 
part of a field. For example, to find all names that start with the letters St, select 
St in one of the name fields.

3.	 On the Home tab, click the Selection button and choose a filtering option.

The options you see are specific to the cell you clicked or the data you selected 
in Step 2. For example, if you click a Last Name field that contains the name 
Smith, your options include Equals “Smith” and Does Not Equal “Smith.” Select 
an option to include or exclude records in the filter operation.
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Filtering for input
Filtering for input gives you the advantage of being able to filter for data ranges. 
Use this technique to isolate records that fall within a numerical or date range. 
Follow these steps to filter for input:

1.	 Display the database table that you want to filter in Datasheet view.

2.	 Select the field with the data you want to use for the filter operation.

To select a field, click its name along the top of the datasheet.

3.	 On the Home tab, click the Filter button.

As shown in Figure 4-2, a dialog box appears so that you can describe records 
that you want to filter for. You can also open this dialog box by clicking the 
button to the right of a field name.

4.	 Tell Access how to filter the database table.

You can choose values or describe a data range:

•	 Choose values in the field: The dialog box lists all values in the field. 
Deselect the Select All check box and then click to select the values you 
want to filter with.

•	 Describe a numeric or date range: Choose Number Filters or Date Filters 
and select a comparison operator on the submenu (refer to Figure 4-2). The 
Custom Filter dialog box appears. Enter a comparison value and click OK.

You can repeat Steps 2 through 4 to filter the database table even further.

FIGURE 4-2:  
Filtering by input 
for numeric data 

values.
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Filtering by form
Filtering by form is a sophisticated filtering method. It permits you to filter in 
more than one field using an OR search. For example, you can tell Access to look 
in the Last Name field for people named Martinez, as well as look in the City field 
for Martinezes who live in Los Angeles or San Francisco. Moreover, you can use 
comparison operators in the filter operation. Follow these steps to filter by form:

1.	 In Datasheet view, go to the Home tab, click the Advanced button, and 
choose Filter by Form on the drop-down list.

Only field names appear on the datasheet, as shown in Figure 4-3.

2.	 Click in a field, open its drop-down list, and enter a comparison value or 
select a value on the drop-down list.

You can choose a value on the drop-down list or, in Number and Currency 
fields, enter a comparison operator and a value. Table 4-1 explains the 
comparison operators.

3.	 If you want, enter more criteria for the filtering operation.

You can enter values in other fields as well as filter more than once in the same field.

•	 Enter values in other fields: Open the drop-down list in a field and enter 
a comparison value or select a value on the drop-down list.

•	 Filter more than once in the same field: Select a field in which you 
already entered a search criterion. Then click the Or tab and either enter a 
comparison value or choose a value from the drop-down list.

FIGURE 4-3:  
Filtering by form.
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When you click the Or tab, the search choices you made previously 
disappear from the screen. Don’t worry — Access remembers them 
on the Look For tab. You can click the Or tab again if you want to enter 
more criteria for Or searching.

4.	 Click the Toggle Filter button.

The results of the filtering operation appear in the datasheet.

Querying: The Basics
Querying means to ask a question of a database and get an answer in the form of 
records that meet the query criteria. Query when you want to ask a detailed ques-
tion of a database. “Who lives in Los Angeles and donated more than $500 last 
year?” is an example of a query. So is, “Which orders were purchased by people 
who live in California and therefore have to pay sales tax, and how much sales tax 
was charged with these orders?” A query can search for information in more than 
one database table. For that matter, you can query other queries for information. 
A query can be as sophisticated or as simple as you need it to be. In the results of the 
query, you can show all the fields in a database table or only a few necessary fields.

Access offers several different ways to query a database (the different techniques 
are described later in this chapter, in “Six Kinds of Queries”). Still, no matter 
which kind of query you’re dealing with, the basics of creating and running a query 
are the same. You start on the Create tab to build new queries. To open a query 

TABLE 4-1	 Comparison Operators for Filtering and Querying
Operator Name Example

< Less than <10, any number smaller than ten

<= Less than or equal to <=10, ten as well as any number smaller than ten

> Greater than >10, any number larger than ten

>= Greater than 
or equal to

>=10, ten as well as any number equal to or larger than ten

= Equal to =10, ten — not any other number

<> Not equal to <>10; all numbers except ten (instead of <>, you can enter 
the word not)

Between . . . And . . . Between Between 10 And 15, a number between 10 and 15 or equal 
to 10 or 15
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you already created, double-click its name on the Navigation pane. The following 
pages introduce you to queries, how to create them, and how to modify them.

Creating a new query
To create a new query, start on the Create tab and click the Query Design or Query 
Wizard button.

»» Create the query in Design view. Click the Query Design button to see the 
Query Design window, as shown in Figure 4-4, as well as the Show Table 
dialog box for telling Access which database tables to query. Construct your 
query in the Design window (the following pages explain how).

»» Create the query with a wizard. Click the Query Wizard button to display the 
New Query dialog box and then choose a wizard option (four possible Query 
Wizards are available) and answer the questions that the Query Wizard asks. 
You’re asked which table or tables to query, which fields to include in the 
query, and which fields to include in the query results (the following pages 
explain these issues).

FIGURE 4-4:  
The Query Design 

window.
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To run a query, open the query in the Query window, go to the (Query Tools) Design 
tab, and click the Run button. The results of the query appear in Datasheet view.

Viewing queries in Datasheet  
and Design views
Select a query on the Navigation pane and use these techniques to view it in Data-
sheet or Design view. Datasheet view shows the results of running a query. Create 
and modify queries in Design view.

»» Opening in Design view: Right-click the query’s name in the Navigation pane 
and choose Design View on the shortcut menu.

»» Opening in Datasheet view: On the Navigation pane, double-click the 
query’s name or right-click its name and choose Open on the shortcut menu.

»» Switching between views with the View button: On the Home tab, open 
the drop-down list on the View button. Then choose Design View or Datasheet 
View on the drop-down list.

»» Switching between views on the status bar: Click the Datasheet View or 
Design View button on the right side of the status bar.

»» Switching between views by right-clicking: Right-click the query’s title bar 
and choose Datasheet View or Design View.

Finding your way around the  
Query Design window
The Query Design window (refer to Figure 4-4) is where you construct a query 
or retool a query you constructed already. Switch to Design view to see the Query 
Design window. You see this window straightaway after you click the Query Design 
button to construct a new query. The Query Design window is divided into halves:

»» Table pane: Lists the database tables you’re querying as well as the fields in 
each table. You can drag the tables to new locations or drag a table border to 
change its size and view more fields.

»» Design grid: Lists which fields to query from the tables, how to sort the query 
results, which fields to show in the query results, and criteria for locating 
records in fields.
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Choosing which database tables to query
To choose which database tables (as well as queries) to get information from, go 
to the (Query Tools) Design tab and click the Show Table button. You see the Show 
Table dialog box (refer to Figure 4-4). The Tables tab lists all the database tables 
you created for your database. Ctrl+click to select the tables you want to query and 
then click the Add button. To query a query, go to the Queries tab and select the 
query. Query a query to refine the query and squeeze yet more detailed informa-
tion out of a database.

The tables and queries you choose appear in the Table pane of the Query Design 
window (refer to Figure 4-4). To remove a table from a query, right-click it in the 
Table pane and choose Remove Table on the shortcut menu.

To query more than one table, you need to establish relationships among tables. 
(Chapter  2 of this minibook has information about establishing relationships 
among database tables.) So-called join lines in the Query Design window show 
how the tables are related to one another.

If you haven’t defined relationships between the tables, you can still join them 
together by dragging a field from one table onto a field in another table. This is 
the same method used to create relationships between tables. Joining tables in a 
query doesn’t create an actual relationship; it’s just a temporary join for the sake 
of the query.

Choosing which fields to query
After you choose which tables to query, the next step is to choose which fields to 
query from the tables you selected. The object is to list fields from the Table pane 
in the first row of the Design grid. Fields whose names you enter in the first row 
of the Design grid are the fields that produce query results, as demonstrated by 
Figure 4-5.

Access offers these techniques for listing field names in the first row of the Design 
grid:

»» Dragging a field name: Drag a field name into a column on the Design grid. 
The field name appears on the grid, as does the name of the table that you 
drag the field name from.

»» Double-clicking a field name: Double-click a field name to place it in the next 
available column in the Design grid.
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»» Choosing a table and field name: Click in the Table row, open the drop-
down list, and choose the name of a table. Then, in the Field box directly 
above, open the drop-down list and choose a field name.

»» Selecting all the fields in a table: In the unlikely event that you want all 
the fields from a table to appear in the query results, either double-click the 
asterisk (*) at the top of the list of field names or drag the asterisk into the 
Design grid. Access places the name of the table followed by an asterisk in 
the Field text box. The asterisk signifies that all the fields from the table are 
included in the query.

To remove a field name from the Design grid, select it and press the Delete key or 
go to the (Query Tools) Design tab and click the Delete Columns button.

Sorting the query results
At the start of this chapter, “Sorting Records in a Database Table” explains what 
sorting is. The Sort row of the Design grid  — directly underneath the Table 
name — contains a drop-down list. To sort the query, click the drop-down list 
in a field and choose Ascending or Descending to sort the results of a query on a 
particular field. To sort the results on more than one field, make sure that the first 
field to be sorted appears to the left of the other fields. Access reads the sort order 
from left to right.

FIGURE 4-5:  
How query fields 

translate into 
query results.
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Choosing which fields appear  
in query results
Although a field is part of a query and is listed in the Query grid, displaying infor-
mation from the field in the query results isn’t always necessary. Consider the 
Query grid shown in Figure 4-6. The object of this query is to get a list of cus-
tomers by ZIP code that ordered products in the year 2018. To that end, the query 
criteria cell in the Order Date field is Between #1/1/2018# And #12/31/2018#. 
However, when the query results are generated, listing the precise dates when the 
orders shipped isn’t necessary because the object of the query is to get a list of 
customers by ZIP code who ordered products in 2018.

Whether a field’s Show check box is selected in the Query grid determines whether 
its results are part of the query results. Deselect the Show box if a field is neces-
sary for producing records in a query but not necessary in the query results. By 
the way, after you save and reopen a query, Access moves deselected Show fields 
to the right side of the Query grid, where you usually have to scroll to see them.

Entering criteria for a query
What separates a run-of-the-mill query from a supercharged query is a criterion, 
an expression or value you enter on the Criteria line under a field. Enter criteria on 
the Criteria line of the Query grid. By entering criteria, you can pinpoint records 
in the database with great accuracy. In Figure 4-7, the Query grid instructs Access 
to retrieve orders with invoices due before January 1, 2016 that charged more 
than  $2,000 and were shipped to Massachusetts (MA), Connecticut (CT), or 
New York (NY).

MOVING FIELD COLUMNS  
ON THE QUERY GRID
The order in which field names appear in the Query grid is also the order in which they 
appear in the query results (refer to Figure 4-5). Follow these steps to put field columns 
in the right order in the Query grid:

1.	 Click a column’s selector button to select a column.

This button is the narrow gray box directly above the field name. The pointer turns 
into a downward-pointing arrow when you move it over the selector button.

2.	 Click the selector button again and drag the column to the left or right.
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As Figure  4-7 shows, Access places double quotation marks (“”) around text 
criteria and number signs (#) around date criteria. When you enter text or date 
criteria, don’t enter the double quotation marks or number signs. Access enters 
them for you.

When you need help writing an expression for a query, try clicking the Builder 
button to construct your query in the Expression Builder dialog box. This button is 
located on the (Query Tools) Design tab.

Entering numeric criteria
Enter numeric criteria in Number and Currency fields when you want to isolate 
records with specific values. Earlier in this chapter, Table 4-1 describes compari-
son operators that you can use for querying and filtering. These operators are 
invaluable when it comes to mining a database for information. Use the greater 
than (>) and less than (<) operators to find values higher or lower than a target 
value. Use the Between operator to find values between two numbers. For exam-
ple, Between 62 And 55 in a Currency field isolates records with all items that sell 
for between $62.00 and $55.00.

FIGURE 4-6:  
Choosing what 
appears in the 
query results.
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Do not include commas in numbers when you enter them as criteria. For example, 
enter 3200, not 3,200. Enter a comma and you get a “The expression you entered 
contains invalid syntax . . .” error message.

Entering text criteria
To enter a text criterion, type it in the Criteria text box. For example, to find stu-
dents who attended the Ohio State University, enter Ohio State in the Criteria text 
box of the University field. Access places double quotation marks (“”) around the 
text you enter when you move the pointer out of the Criteria text box.

Wildcards and the Not operator can come in very handy when entering text criteria:

»» Wildcards: Wildcards enable you to query for data whose spelling you aren’t 
quite sure of. (In Chapter 3 of this minibook, Table 3-2 explains what the 
wildcard characters are and how to use them.) For example, entering Sm?th in 
the Criteria box of the Last Name field finds all Smiths and Smyths. Entering 
E* in the Company field finds all company names that begin with the letter E.

»» Not operator: Use the Not operator to exclude records from query results. 
For example, to exclude records with Belgium in the Shipped To field, enter 
Not Belgium in the Criteria text box. This is a great way to strip unneeded 
records from a query.

FIGURE 4-7:  
Including criteria 

in a query.
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Entering date criteria
All the operators that work for numeric data (see Table 4-1, earlier in this chapter) 
also work for data entered in a Date field. For example, you would enter >7/31/1958 
in a Birth Date field to find all people born after (greater than) July 31, 1958. You 
would enter Between 1/1/1920 And 12/31/1929 to retrieve data about people born 
in the Roaring Twenties.

Access places number signs (#) around date criteria after you enter it. You can 
enter dates in the following formats:

»» 11/22/19

»» 11/22/2019

»» 22-Nov-19

»» November 22, 2019

For the purpose of entering two-digit years in dates, the digits 30 through 99 
belong to the twentieth century (1930–1999), but the digits 00 through 29 belong 
to the twenty-first century (2000–2029). For example, >4/1/24 refers to April 1, 
2024, not April 1, 1924. To enter a date in 1929 or earlier, enter four digits instead 
of two to describe the year: >4/1/1929. To enter a date in 2030, or later, enter four 
digits instead of two: >4/1/2038. To avoid any confusion, enter four-digit years 
all the time.

The Date() function can come in very handy when you want to retrieve data rela-
tive to today’s date, whatever it happens to be. For example, to retrieve purchase 
orders made between January 1, 2009 and today’s date, enter this expression: 
Between 1/1/2009 And Date().

At last — saving and running a query
To save a query and inscribe its name forever in the Navigation pane, click the Save 
button on the Quick Access toolbar and enter a descriptive name in the Save As 
dialog box. The name you enter appears in the Queries group in the Navigation pane.

After you laboriously construct your query, take it for a test drive. To run a query:

»» Starting from the Query Design window: Click the Run button on the 
(Query Tools) Design tab.

»» Starting from the Navigation pane: Double-click an existing query’s name, 
or right-click its name and choose Open on the shortcut menu.
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Six Kinds of Queries
For your pleasure and entertainment, the rest of this chapter describes six useful 
types of queries. Access offers a handful of other queries, but I won’t go there. 
Those queries are pretty complicated. If you become adept at querying, however, 
you’re invited to look into the Help system for advice about running the query 
types that aren’t explained here.

Select query
A select query is the standard kind of query, which I explain earlier in this chapter. 
A select query gathers information from one or more database tables and displays 
the information in a datasheet. A select query is the most common query, the pri-
mal query, the starting point for most other queries.

Top-value query
A top-value query is an easy way to find out, in a Number or Currency field, the 
highest or lowest values. On the Query grid, enter the name of the Number or 
Currency field you want to know more about; then choose Ascending in the Sort 
drop-down list to rank values from lowest to highest or Descending in the Sort 
drop-down list to rank values from highest to lowest. Finally, on the (Query Tools) 
Design tab, enter a value in the Return text box or choose a value on the Return 
drop-down list:

»» Highest or lowest by percentage: Enter or choose a percentage to find, for 
example, the highest or lowest 25 percent of the values. To enter a percent-
age, type a percent sign (%) after your entry and press the Enter key.

»» Highest or lowest by ranking number: Enter or choose a number to find, 
for example, the top-ten or lowest-ten values. Press the Enter key after you 
enter a number.

This may seem counterintuitive, but to see the top values, you have to sort the 
field you’re ranking in descending order. For example, if you sort employees by 
number of sales in descending order, the employees with the top sales appear at 
the top. To see the bottom values, sort in ascending order.

Summary query
Similar to a top-value query, a summary query is a way of getting cumulative 
information about all the data in a field. In a field that stores data about sales in 
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Kentucky, for example, you can find the average amount of each sale, the total 
amount of all the sales, the total number of all the sales, and other data.

To run a summary query, go to the (Query Tools) Design tab and click the Totals 
button. A new row called Total appears on the Query grid. Open the Total drop-
down list in the field whose contents you want to summarize and choose a func-
tion. Table 4-2 describes the functions.

The Group By, Expression, and Where choices in the Totals drop-down list are for 
including fields you’re not performing a function on:

»» Group By: For choosing which fields to show totals for

»» Expression: For creating a calculated field

»» Where: For setting criteria (you can’t include the field in the query)

Calculation query
A calculation query is one in which calculations are performed as part of the query. 
For example, you can calculate the sales tax on items sold or total the numbers in 
two fields in the same record. The beauty of a calculation query is that the data is 
recomputed each time you run the query. If the data used to make a calculation 
changes, so does the result of the calculation. If you were to include the calculation 

TABLE 4-2	 Summary Query Functions
Function Returns

Sum The total of all values in the field

Avg The average of all values

Min The lowest value

Max The highest value

Count The number of values

StDev The standard deviation of the values

Var The variance of the values

First The first value

Last The last value
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in a database table, you would have to recalculate the data yourself each time one 
of the values changed. With a calculation query, Access does the math for you.

To construct a calculation query, you create a new field in the Query grid for stor-
ing the results of the calculation; then enter a name for the field and a formula for 
the calculation. Follow these steps to create a calculation query:

1.	 Create a query as you normally would and be sure to include the fields 
you want to use for calculation purposes in the Query grid.

2.	 In the Field box of a blank field, enter a name for the Calculation field and 
follow it with a colon.

In Figure 4-8, I entered Subtotal:. The purpose of the new Subtotal field is to 
multiply the Unit Price by the Quantity.

3.	 After the colon, in square brackets ([]), enter the name of a field whose 
data you use for the calculation.

In Figure 4-8, data from the Unit Price and Quantity fields are used in the 
calculation, so their names appear in square brackets: [Unit Price] and 
[Quantity]. Be sure to spell field names correctly so that Access can recognize 
them.

4.	 Complete the calculation.

How you do this depends on what kind of calculation you’re making. In 
Figure 4-8, I entered an asterisk (*) to multiply one field by another. The 
equation multiplies the values in the Unit Price and Quantity fields. You can 
add the data from two different fields — including calculated fields — by 
putting their names in brackets and joining them with a plus sign, like so: 
[SubTotal]+[Shipping Cost].

Sometimes the results of the query aren’t formatted correctly on the datasheet. 
To assign a new format to a field that you create for the purposes of making a cal-
culation query, right-click the field on the Query grid and choose Properties. The 
Property Sheet appears. On the General tab, click the Format drop-down list and 
choose the correct format for your new, hand-crafted field.

Delete query
Be careful about running delete queries. A delete query deletes records and doesn’t 
give you the opportunity to get the records back if you change your mind about 
deleting them. If used skillfully, however, a delete query is a great way to purge 
records from more than one database table at one time. Back up your database file 
before running a delete query.
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To run a delete query, start a new query, and on the (Query Tools) Design tab, click 
the Delete button. Then make as though you were running a select query but tar-
get the records you want to delete. Finally, click the Run button to run the query.

You can delete records from more than one table as long as the tables are related 
and you chose the Cascade Delete Related Records option in the Edit Relationships 
dialog box when you linked the tables. (See Chapter 2 of this minibook for advice 
about forging relationships between tables.)

To preview the records that will be deleted before you run the delete query, switch 
to Datasheet view (click the View button). Those records you see? The delete query 
will delete them if you click the Run button.

FIGURE 4-8:  
A calculation 

query.
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Update query
An update query is a way to reach into a database and update records in several 
different tables all at one time. Update queries can be invaluable, but as with delete 
queries, they can have untoward consequences. Back up your database before you 
run an update query; then follow these steps to run it:

1.	 Starting in Design view, go to the (Query Tools) Design tab and click the 
Update button.

2.	 In the field with the data that needs updating, enter text or a value in the 
Update To line. You can even enter another field name in square brack-
ets ([]).

What you enter in the Update To line replaces what’s in the field of the records 
you collect.

3.	 Click the Run button.

To update records in more than one table, you must have chosen the Cascade 
Update Related Fields option in the Edit Relationships dialog box when you linked 
the tables. (See the section in Chapter 2 of this minibook about forging relation-
ships between tables.)
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       Presenting Data 
in a Report    

        T  he prettiest way to present data in a database table or query is to pres-
ent it in a report. Even people who are allergic to databases can put up 
with database material in a report. Reports are easy to read and understand. 

They succinctly present the data so that you and others can interpret it. This brief 
 chapter explains how to create reports, open them, and edit them.  

  Creating a Report 
 Access comes with all kinds of complicated tools for fashioning your own report — 
for laying out the pages in diff erent ways and making data fi elds show up in 
 diff erent parts of the page. If ever a task called for relying on a wizard, creating 
a report is it. You can save yourself a lot of trouble, and fashion sophisticated-
looking reports as well, by dispensing with the fancy report-making tools and 
letting the wizard do the job. 

Chapter 5

 IN THIS CHAPTER 

 »     Creating a new report  

 »   Opening a report  

 »   Changing the look of a report    
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What’s more, the easiest and best way to make a report is to base your report on 
a query. As part of fashioning a report with a wizard, you can tell Access which 
database tables and which fields to get the data from. In other words, you can 
query your database from inside the Report Wizard. However, doing that requires 
turning somersaults and cartwheels. Far easier is to run a query to produce the 
results you want in your report, save your query, and then fashion a report from 
the query results. Chapter 4 in this minibook explains how to create a query.

Figure 5-1 shows a report created with the Report Wizard. To create a report with 
the Report Wizard, go to the Create tab and click the Report Wizard button. You 
see the first of several Report Wizard dialog boxes. Negotiate the dialog boxes as 
follows, clicking the Next button as you go along:

»» Tables/Queries: Open the Table/Queries drop-down list and choose the 
query where the information in the report will come from. A list of fields in the 
query appears in the Available Fields box.

»» Available Fields and Selected Fields: Select the fields whose data you want 
in the report by selecting the fields one at a time and clicking the > button. 
Doing so moves field names from the Available Fields box to the Selected 
Fields box. Add all the fields by clicking the >> button.

»» Do You Want to Add Any Grouping Levels?: Include subheadings in 
your report by selecting a field name and clicking the > button to make 
it a subheading. If you’re building your report on a query that includes 
related tables, the Report Wizard automatically adds subheadings.

»» What Sort Order Do You Want?: Select up to four fields to sort the data in your 
report. Even if you sort the fields in a query, the report handles sorting on its 
own. If you include grouping levels, the report already sorts on these fields.

»» How Would You Like to Lay Out Your Report?: Experiment with the options, 
and watch the Preview box, to choose a layout for your report. If your report 
has a lot of fields, you may want to print it in Landscape view.

»» What Title Do You Want for Your Report?: Enter a descriptive title. The 
name you choose appears in the Reports group in the Navigation pane. 
From there, you double-click the name when you want to see the report.

»» Preview the Report: Select this option button and click Finish.

The report appears in the Preview window. How do you like it? Later in this 
chapter, “Tweaking a Report” offers some tips for making a report look spiffier.
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Opening and Viewing Reports
If you’ve spent any time whatsoever in Access, you know the drill for opening a 
so-called object. Follow these steps to open a report:

1.	 In the Navigation pane, select the Reports group.

You see the names of reports you created.

2.	 Double-click a report name or right-click a name and choose Open from 
the shortcut menu.

The report appears in Report view.

To update a report so that it includes recently added data, go to the Home tab and 
click the Refresh All button.

Tweaking a Report
As I mention at the start of this chapter, Access offers a bunch of complex tools 
for changing the layout and appearance of a report. If you’re courageous and have 
lots of time on your hands, you’re invited to take these tools in hand and go to 

FIGURE 5-1:  
An example  
of a report.
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it. In the Reports group of the Navigation pane, right-click a report and choose 
Layout View on the shortcut menu. Your report appears in Layout view, as shown 
in Figure 5-2. In this view, using tools on the Report Layout Tools tabs, you can 
tweak your report’s appearance.

I tell you how to create a report with the Report Wizard in order to avoid your hav-
ing to visit this imposing window. However, you can change a report’s appearance 
in Layout view without going to very much trouble if you follow these instructions:

»» Choosing a new layout: On the (Report Layout Tools) Arrange tab, click the 
Stacked or Tabular button, or click the Gridlines button and choose an option 
on the drop-down list, to change your report’s layout.

»» Including page numbers: To include page numbers on the report, go the 
(Report Layout Tools) Design tab and click the Page Numbers button. You see 
the Page Numbers dialog box shown in Figure 5-3. Choose the Page N option 
button to display a page number only, or select the Page N of M option button 
to display a page number as well as the total number of pages in the report 
(as in “Page 2 of 4”). Choose Position and Alignment options to describe where 
on the page to put the page number.

»» Changing the margins: On the (Report Layout Tools) Page Setup tab, click the 
Margins button and select Normal, Wide, or Narrow on the drop-down list.

FIGURE 5-2:  
The report in 
Figure 5-1 in 
Layout view.
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FIGURE 5-3:  
Putting on the 

page numbers.

AN EASIER WAY TO TWEAK  
A REPORT — IN WORD
An easier way to tweak a report is to transfer your report to Microsoft Word and edit it 
there. Follow these steps to turn an Access report into a Word document:

1.	 On the External Data tab, click the More button in the Export group and 
choose Word on the drop-down list.

You see the Export - RTF File dialog box.

2.	 Click the Browse button, and in the File Save dialog box, choose a folder for 
storing the Word document; then click the Save button.

3.	 In the Export - RTF File dialog box, choose Open the Destination File After the 
Export Operation Is Complete.

4.	 Click the OK button.

In a moment, your Access report appears in Word. The file is an RTF (rich text format) 
file. To save it as a Word file, go to the File tab, choose Save As, click the Browse button, 
and in the Save As dialog box, open the Save As Type drop-down list and choose Word 
Document. Books 1 and 2 describe how to work with files in Word.
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